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A Peek into Windows  

Since the mid-1990’s, Windows Server has been the brand name for the Microsoft family of 

server operating systems. The majority of businesses who install Windows Server will not have 

IT as their major focus, but instead Windows Server is typically used to provide tools and 

services to support those work environments. Whether it is a small mom and pop shop or a 

Fortune 500 company, Windows Server is used as the foundation to provide services such as 

email, websites, and data security.   

 

There are other manufacturers of server operating systems, such as Linux. However, Windows 

Server provides a stable, easy to use platform that is found in the majority of networks. It is 

because of Microsoft’s large user base that you will find a broader support for software 

applications and hardware devices for Windows Server over competing server products.  

 

In addition, the rapidly changing world of more mobile, more connected and more data driven 

working environments has transformed how we do business. Windows Server provides the 

framework to support new flexible services, agile applications, and the proliferation of Bring 

Your Own Device (BYOD) work environments 

 

The very reason for this book is that Windows Server is the product that most people learn 

when they are first entering the IT workplace or the operating system that the accidental 

administrator is likely to find when asked to assist with Windows Server Administration. 

 

Windows Server is a very large topic and there have been many versions and editions over the 

years. However, this book is meant to be version and edition neutral as much as possible. We 

want to focus on what you need to get up and going to perform day-to-day Windows Server 

Administrator in a very short matter of time. In addition, we try to avoid deep dives into the 
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theoretical background information. While I believe that information is important, it is not the 

purpose of this book. We are more concerned in how to get the tasks done that are needed to 

be a successful Windows Server Administrator. 

As previously mentioned, this book is meant to be about getting tasks done and less about 

concepts and theory. However, we do need to know a little vocabulary before we begin. In this 

chapter we cover the key terms and concepts needed for this book as well as for your career 

as a Windows Server Administrator.  

 

The majority of all computer related work activity is performed on a machine located at your 

desk. This machine could be running a series of programs to assist you in getting your job 

done in a timely and efficient manner. While there are other products out there, Microsoft 

products and services are found in an overwhelming majority of companies. This is regardless 

of the size or type of company. As part of our daily tasks many of us need to share documents, 

files, and information with other people in our office or vendors or customers. This is done by 

physically connecting or networking the computers together. However, after we have 

connected the computers together we need to have other computers to manage, authorize, 

and control this network communication. This is the role of the Windows Server computers in 

our network. Now we just need someone who can administer those Windows Servers.  

 

Getting to Know Windows Server 
 

 

 

Figure 2.1 Windows Server Network 
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As you can see in the Figure 2.1, we connect or network these computers together to be able 

to collaborate with others within our company. As we will see later in this chapter the 

computers that are used to perform daily work tasks will be our client devices. However, for 

our client devices to perform specific tasks they would need to contact or request services from 

a machine that is managing our network. This would be one of the machines that has Windows 

Server running on it. These Windows Servers will have services running on them to provide 

the resources needed that will authenticate users on the network, provide addresses to our 

client devices, secure access for our files and printers, and many other services as needed.  

 

Over the course of this book you will learn how to manage, administer, and troubleshoot the 

primary services of a Windows Server such as Networking Services, Active Directory Domain 

Services, File Services, and Print Services.  

 
Some important terminology 

2.1.1 Client vs. Server 

 

Figure 2.2 Client vs. Server 

If during your lunch you walk down the street to the little café on the corner and sit down at 

one of the tables, a very nice person will show up to take your order. You might order a bacon 

sandwich, salad, and a glass of water. The very nice person then goes to the kitchen of the 

little café and brings back your order in response to your request. 

 

This is exactly the concept of a client and server relationship in computer networking. A client 

is any application or service that requests information and a server is any application or service 

that provides that information.  
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2.1.2 Hardware vs. Software 

HARDWARE 

Hardware is an overall term used to describe any of the physical components of a computer. 

Within your computer case you will have a system board commonly referred to as the 

motherboard. The motherboard is used to connect all the other pieces of your computer 

together.  The four primary components of hardware that are in your computer are called the 

Central Processing Unit (CPU), hard drive, memory, and network adapter card. We will cover 

these hardware components in more detail later in this chapter. 

 

SOFTWARE 

Software is a set of instructions used by your computer to tell your hardware how to perform 

specific tasks. The software that is first installed on a machine is referred to as the Operating 

System (OS) and is used to tell the hardware how to operate the system.  

2.1.3 Clients Devices and Server Computers 

CLIENT DEVICES 

You may be very familiar with working with a desktop, laptop, or tablet. These are typically 

considered client devices. However, for the hardware to operate correctly they would need 

software to give the hardware instructions on how to operate the system. For your client 

devices this would be an operating system (OS) such as Windows 8.1 or Windows 10.  

 

In addition, you could install additional software onto your operating system that allows you 

to perform specific tasks such as working on a spreadsheet, checking your email, or browsing 

the Internet. This additional software is what is called your application software. 

 

SERVER COMPUTERS 

For a larger networked environment your company will probably have more powerful machines 

hidden in very cold rooms. These computers would be the hardware that is considered your 

server machines and would need more CPU processing power, larger hard drives for storage, 

more memory, and possibly faster network adapter cards. And just like your client devices 

needed software to give the hardware instructions on how to operate; your server machines 

will also need an operating system. And in a Microsoft environment this would be the Windows 

Server operating system which is the main focus of this book.  

 

Once the Windows Server operating system is installed you could add Roles and Features that 

would provide Authentication and Networking services for your environment. You could also 

install additional application software that provides specific tasks for your network. For 

example, you may have Outlook software installed on your client device to read email and on 

the server computer you would have Exchange Server software installed to store and transport 

email.  
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Remember in our previous example when you were the client sitting in the front-end of the 

little cafeteria? The person or server taking your order went to the back-end of the café to 

retrieve your sandwich, salad, and water. When you have application software that has 

components on both the client machine and the server machine, the software on the client 

machine is considered the front-end part of the application and the software on the server 

machine is considered the back-end part of the application. 

THREE TYPE OF SERVERS 

Once Windows Server has been installed you will find that there are three types of servers 

available depending on how they are configured in your network. These three server types are 

Standalone Servers, Member Servers, and Domain Controllers. 

 

 Standalone Server – Window Server installed but is not a member of the domain. 

 Member Server – Windows Server installed but is a member of the domain. 

 Domain Controller – Active Directory Domain Services installed to control domain. 

 

A standalone server can typically be found in a workgroup or peer-to-peer network. This is for 

small office or home office (SOHO) networks with 10 or less connected devices and will not 

have a centralized location for user and computer accounts.  

 

A member server would be part of a domain environment that would provide application 

services to end users in larger networks, but would not have the directory services installed to 

authenticate users and computers.  

 

A domain controller would also be part of a domain environment, but would have Active 

Directory Domain Services installed that would hold user and computer accounts to provide 

authentication and authorization services to the domain environment. This is also were your 

Group Policies are stored to control Desktop Settings, Security Configuration of the client 

devices in your network. 

 

WORKGROUP VS. DOMAIN 

Since we just mentioned workgroups and domains, it might be a good time to describe the 

differences between these two logical network designs.  

 

A workgroup is for smaller networks with a mixture of client operating systems and server 

operating systems connected together in a peer- to-peer environment where authentication of 

user accounts is decentralized down to the individual computer. Meaning in a workgroup of 10 

computer devices you could possibly have 10 separate user names and passwords.  
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2.2 Four Core Hardware Components 

For each of our computers whether they are a client device or a server computer there will be 

four core hardware components. These components are the Central Processing Unit (CPU), 

Hard Drive or storage device, Memory or RAM, and a Network Interface Card (NIC). Let us 

take a closer look at each of these items one at a time. An easy way of thinking of these 

computer elements is to re-visit the kitchen of the lunch café. 

 

Figure 2.3 Hardware Components in the Kitchen 

CENTRAL PROCESSING UNIT (CPU) 

In the kitchen of our little café on the corner you will have a chef who will prepare your meal. 

This is very similar to our CPU which processes the instructions from the operating system and 

application software. The faster our chef can put our order together, the faster we get our 

lunch. Now imagine we have two or even four chefs in the kitchen… That is a lot of bacon 

sandwiches getting made. This is similar to our server computer if it had two processor chips 

(Dual Core) or four processor chips (Quad Core). The more CPUs the faster our Server 

computers can perform. 

MEMORY (RAM) 

While our chef is making our lunch order she needs an area to temporarily place the cooking 

utensils, dishes, and ingredients needed for our meal. She would place them on the kitchen 

counter so that they would be close at hand and thereby speed up the preparation time of our 

sandwich and salad. This is very similar to the Memory or RAM in your computer. While the 

CPU is processing operation instructions it will need a temporary storage place for data that 

needs to be immediately accessible. That temporary storage place is your Random Access 

Memory (RAM) or just simply referred to as memory. 

STORAGE (HARD DRIVES) 

The chef of our favorite little café is a trained professional. She knows that when not using her 

cooking utensils, dishes, and pans they need to be placed or stored in the cabinets of the 

kitchen for when she needs to use those items in the future. Within or computer we place or 

store our files and folder on a hard drive for use at a later time. There are other types of 
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storage other than the internal hard drive within the computer. We could also store files on 

USB drives for portable storage or in a Server environment we could use a Storage Area 

Network (SAN) which is basically just a large cabinet with a bunch of drives available to store 

our data. 

NETWORK INTERFACE CARD (NIC) 

One of the reasons we like our little café so much is that the chef likes to drive to the garden 

market to purchase fresh ingredients. While out shopping she might stop at the Post Office to 

drop off some packages or stop by the library to check out a new cooking book. When she 

comes back from her errands she parks outside in her private parking space. 

 

We might be stretching our café analogy here, but you can think of the parking space as the 

chef’s network adapter. She knows how to get to the Post Office (Exchange Server), Library 

(SQL Server), and Fresh Garden Market (Supermarket Website) because of the addresses of 

their prospective locations. After she has visited each location, she returns back to the address 

of the parking space in front of the café. 

 

In computers, each of our Network Interface Cards (NIC) have their own unique Internet 

Protocol (IP) address to allow each of the computer to communicate with each other. The 

linking of all these computer with each other is what makes up a network of computers.  

 

2.3 Finding System Information 

Since we have talked about the core hardware components now would be a good time to 

perform a quick task to see if you can locate the information about your own computer. One 

way to locate your system information on your client device or server machine is with the 

System Information screen. Find it like this: 

 

1. Right click on your Windows button and select Control Panel. (Figure 2.4) 

2. Click on System and Security. (Figure 2.5) 

3. Click on System. (Figure 2.6) 

4. Review your System Information (Figure 2.7) 
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Figure 2.4 .Windows Menu Button and Control Panel 

 

Figure 2.5. System and Security in Category view 
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Figure 2.6 System and Security Options 

 

Figure 2.7 .System Information 

2.4 Server Administration Utilities  

Once the Windows Server operating system has been installed on our server computers we 

need tools and utilities to help us manage or administer our server and network environments. 

These utilities are named Server Manager, Add Roles and Feature Wizard, and PowerShell.  
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3 
Server Manager Tools 

 

Figure 2.1 Windows Server Network 

 

Our chef down at the little café always has a lot of different options available for lunch. 

Depending on our lunch order she knows that she needs to select the correct cooking utensil 

to quickly make our tasty meal. As a Windows Server Administrator we also need to select the 

correct tools and utilities to manage our server environment. We will be discussing these tools 

over the next two chapters, starting with the Server Manager.  
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The Server Manager is the primary tool that we use to maintain our Windows Server 

environment. In reality is more than just one tool, but a collection of tools. It might be easier 

to think of it as a large drawer in your kitchen that holds all of your key cooking utensils. 

 

Instead of having to search different areas of the operating system to locate consoles to 

manage different roles and features, Server Manger allows you to have a one-stop 

management experience. And not for only one server in your network, but you can group, 

organize and manage multiple servers based on server type or administrative needs.  

 

Figure 3.2 Starting Server Manager 

3.1 Getting to Know Windows Server 

 

In many cases, Server Manager will start up when you log on to your Windows Server. 

However, if it does not open, click on the Server Manager icon located on the Taskbar as seen 

in Figure 3.2. You will notice the Server Manager will open directly to the Dashboard as seen 

in Figure 3.3. 
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Figure 3.3 .Server Manager Window 

Across the top of the Server Manager window you will see a gray menu bar that contains many 

of the management consoles and notifications that we will be using throughout this book. On 

the left-hand side of the window you will see the navigation pane that organizes the different 

server roles that are installed and could be managed on the server. The center dashboard 

window is broken down into two main parts. The Welcome to Server Manager Tile gives you a 

Quick Start tool to add server roles and features to your local server. The Roles and Server 

Groups section will allow you to organize the servers you want to manage in your network. 

 

Let us start our tour of the Server Manager window with the gray menu bar across the top of 

the Server Manager window. The two encircled arrows on the left side of the menu bar will 

allow you to navigate up and down the navigation tree. The gray down arrow to the right of 

the two arrows will allow you to return to a previous navigation tree selection. Then you will 

see the name of your current location in the navigation tree. In our example in Figure 2.2 we 

are currently looking at the Dashboard area.  

 

If we click on the word DASHBOARD, this will activate the Search Bar which allows you to 

quickly navigate between different areas of Server Manager. 
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As we move further right we see a recycle/refresh button which allows us to surprisingly refresh 

the window. Next we see our notification flag which gives us information on tasks currently 

running, task errors, or tasks that still need to be accomplished or finished. 

 

Finally, we see the words Manage, Tools, View, and Help. There are a variety of options to 

choose when selecting one of these menus, so let us take a look at these menus one at a time.  

 

First we will start with the Manage menu option as seen in Figure 2.3. This option will allow us 

to Add and Remove Roles and Features, Add Servers and Server Groups, and work with Server 

Manager Properties. Working with Role and Features will be discussed in the next chapter while 

Add Server and Server Groups will be a lesson later in this chapter. For now, let us look at the 

Server Manager Properties as seen in Figure 2.4. 

 

Figure 3.4 – The Manage Menu Option. 

The Server Manager Properties dialog box allows you to configure two basic settings on how 

often you would like the Server Manager data to be refreshed and on whether you would like 

the Server Manager to automatically start when you log in to the server. 
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Figure 3.5 – Server Manager Properties. 

 

Figure 3.6 – Administration Tools. 
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Under the Tools Menu (Figure 3.6) we find all of our Administration Tools needed to manage 

the different Windows Roles and Features that have been installed on the local server. Notice 

that we have our Active Directory Tools installed. This is because we have already installed 

Active Directory on this server, which of course makes it a Domain Controller. Throughout our 

lunches we will cover many of these tools; however some of the more advanced tools are 

outside the scope of this book. We do encourage at a future date to become aware of all of the 

tools as you become more comfortable in the Windows Server Environment.  

 

Figure 3.7 – View Menu. 

The View Menu (Figure 3.7) is exactly what you would think, a way of Zooming In or Out. But 

it is also where you can Hide or Unhide the Welcome to Server Manager Tile. The Welcome Tile 

could also be hidden by clicking the Hide button within the actual Welcome Tile, but you would 

need the View Menu to bring it back.  

 

Finally, the last part of the Server Manager Menu bar is the Help button that can provide help 

on Server Manager which could also be accessed be using the F1 button on your keyboard. 
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The Help menu also will provide links to online resources like the Windows Server Marketplace, 

Windows Server TechCenter and Server Manager Forums.  

3.2 The Dashboard 

 

Figure 3.8 – The Dashboard. 

As mentioned at the beginning of this chapter, The Dashboard window is broken down into two 

main parts. The first of which is the Welcome to Server Manager Tile which as was mentioned 

previously can be hidden or unhidden from the View menu. The Welcome Tile gives you three 

main groupings to get you started. 

 Quick Start 

 What’s New 

 Learn More 
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Quick Start  

This will allow you to Add Roles and Features, Add Other Servers to the Server Manager to 

manage and allow you to create additional Server Groups based on roles or administrative 

needs.  

What’s New? 

This section explains what is new in your Windows Server product including links and 

references to the help section that explains the new features in more detail. 

Learn More 

This section provides links to resources on the Internet to assist you with common problems.  

 

3.3 Roles and Server Groups 

 

The Roles and Server Groups section of the Dashboard will allow you to organize the servers 

you want to manage in your network as seen in Figure 3.9.  

 

Figure 3.9– Roles and Server Groups. 
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On my demonstration server I currently have three roles installed. Active Directory Domain 

Services (AD DS), Domain Name Services (DNS), and File and Storage Services. If I had other 

servers in my network with these same roles I could add them all into their respective Server 

Groups and manage them from the Server Manager.  

 

Figure 3.10 – Add Servers. 

As you can see in Add Servers Wizard show in Figure 2.9 we would be able to add servers 

based on Active Directory or DNS roles. We also have an Import tab that would browse a text 

file as an input and would read any IP address or DNS information for a list of servers.  

 

At this point we would be adding servers to their appropriate groups based on a specific role, 

however, we could also group these servers based on AD Sites, Departments, Administrative 

Groups, Operating System, IP Address, or any other way we might decide to organize the 

servers. 

We create the Custom Server Group either by selecting Manage – Create Server Group from 

the Server Manger menu bar or Create Server Group from the Welcome Tile.  
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Returning back to the Server Groups in Figure 2.6 you may notice that we also have a tile for 

our Local Server, which is currently showing an error or an Event that will need to be fixed. 

We will take a look at the event later in this book. 

 

Within each Server Group tile you should notice five main categories to assist you in quickly 

identifying any issues with those services or servers. All these categories with the exception 

of Manageability can also be found by selecting a role from the Navigation Tree on the left-

hand side of Server Manager. These five categories are 

Manageability 

This will allow the option to view the various status messages of the servers.  

Events 

This provides a centralized view of events or errors that may have happened on the servers. 

Services 

This provides that status of services running or not running on the servers.  

Performance  

This allows the option to monitor for issues with CPU or memory performance on the servers. 

BPA Results 

The Best Practices Analyzer provides suggestions based on best practices for your servers. 

 

3.4 Configuring Local Server Settings 

 

One of the other tools we have within Server Manager is the Local Server settings which 

provide us a centralized location of configuring, managing, and gathering information about 

our local server. We select Local Server from the Navigation Tree located on the left-hand side 

of the Server Manager as seen in Figure 3.10. 
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Figure 3.11 – Local Server Settings 

The first area we look at for our server properties is changing the computer name and 

configuring the workgroup or domain settings. As you can see in Figure 3.10, the current name 

of our server is JDServer2012 and the name of our domain is JDTraining.com. To change either 

of these settings we would need to open up our Systems Properties dialog box which is shown 

in Figure 3.11. This dialog box can be accessed by either clicking on my computer name or 

domain name.  

 

Once this dialog box is open, most people make the mistake of thinking the text box on the 

Computer Name tab is where you would put in the computer name. However, this is just for 

the computer description. To rename the computer or change its domain or workgroup we 

click on the Change button.  

 

Before we click on the Change button, let us take time to notice the Full computer name of my 

server which is JDServer2012.JDTraining.com. The computer or host name is combined with 

the name of my domain to display the Fully Qualified Domain Name (FQDN) of our server.  

 

When we click on the Change button the System Properties dialog box (Figure 3.11) will appear 

that will let us change our computer name as well as being able to change our domain or 

workgroup. Since our example server is a domain controller, we would be unable to change 

the domain or workgroup until we demote the server to a member server by removing Active 

Directory. However, we are still able to rename the server.  
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Renaming a domain controller is typically not recommended as this might cause authentication 

and network communication issues. In addition, renaming any server will require a reboot of 

the server for the name to take effect.  

 

Figure 3.12 – Server System Properties 
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Figure 3.13 – Computer Name / Domain Change dialog box 

The remaining Local Server settings in Server Manager we will discuss later in this book. But 

let us look at a quick overview of these settings.  

 

Windows Firewall 

Helps to prevent hackers or malicious software from gaining access to your server through the 

Internet or your network.  

Remote Management 

Enables applications or commands that require Windows PowerShell remote access to manage 

your server.  

Remote Desktop 

Allows access to the server desktop through a Remote Desktop Protocol (RDP) connection. 
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NIC Teaming 

Allows multiple network adapters on a server to be grouped together to combine bandwidth or 

allow for traffic failover to prevent connectivity loss. 

Ethernet 

Allows you to configure your networking settings such as IP address, Subnet Mask, and Default 

Gateway for your server. 

Last installed updates 

Displays the last time the Windows Update service has updated your server. 

Windows Update 

Provides the settings to configure Windows Update for your server. 

Last checked for Updates 

Displays the last time the Windows Update service checked for new updates. 

Windows Error Reporting 

This will capture software crash and server failures of your server to be used for debugging. 

Customer Experience Improvement Program 

Allows Microsoft to gather information and feedback about your server environment. 

IE Enhanced Security Configuration 

Assigns security zones for the Internet Explorer on your server. 

Time Zone 

Allows you to change the time and time zone of the server. 

Product ID 

Displays the Product ID for your installation of your server. 

 

 

 

 


